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The History of Private School Vouchers 
in Florida 
Florida has two voucher programs: the 
Opportunity Scholarship Program for students 
assigned to failing schools and John M. McKay 
Scholarships for Students with Disabilities, a 
program designed for students whose parents are 
not satisfied with their children’s progress in 
public schools. These two scholarship programs 
are the only statewide voucher programs in the 
nation. 

Vouchers in Florida have been supported for 
two major reasons. First, they offer parents and 
students a choice, particularly low-income 
students who are overly represented in low-
performing schools. Advocates argue that these 
students deserve to have the same choice that 
students in higher income families have had all 
along, because of their ability to choose where 
they live and to pay for private education. 
Second, advocates also argue that vouchers will 
create markets for students in failing schools. 

Vouchers for students in “failing” schools 

Passed in 1999, the Opportunity Scholarship 
Program is part of a broader statewide 
accountability system (the A+ Plan) including 

four major components: student assessment, 
school grading (“A” through “F” for each 
school), public information on school 
performance, and consequences for students and 
schools. As a major consequence for schools, the 
Opportunity Scholarship Program offers 
vouchers to students attending public schools 
that have received a failing grade for two out of 
four consecutive years, regardless of their 
achievement level or family income.  
(Continued on p. 2.) 

MESSAGE FROM THE  

PEA PREZ    

Kenneth K. Wong, Vanderbilt University 
 
Greetings!  You have given me a lot of good 
ideas on how to move PEA forward at our well-
attended business meeting in New Orleans.  
Since AERA, many of you have generously 
accepted my invitation to serve on committee 
assignments.  I would like to take this 
opportunity to thank you for your commitment to 
the PEA.  It is because of your support that we 
are able to maintain this association for 33 years!                   
(Continued on p. 6.) 
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(Continued from p. 1.) 
Students may use the vouchers to attend a 

participating private school; religious or non-
religious; or to attend a public school (in the 
same or another school district) earning a grade 
of “C” or better. A private school must accept 
the voucher provided by the state as full tuition 
and fees for each student. The State sends the 
private school a check - made out to the parent, 
not the school – to cover the tuition cost to the 
participating private school. 

The parent must endorse the check. A 
student’s parent or guardian may choose to 
return the student to an eligible public school at 
any time, upon reasonable notice. 

In 2000-01, two elementary schools in 
Escambia County received two “F”s in four 
years making their students eligible for vouchers; 
57 accepted vouchers to private schools. Ten 
additional schools in Dade, Orange, and Palm 
Beach counties were designated as failing 
schools in the summer of 2002. As of the 
beginning of the 2002-03 school year, Florida 
had a total of 624 students receiving opportunity 
scholarships to private schools, including 580 
new voucher students from Dade, Orange, and 
Palm Beach Counties, and 44 students who are 
continuing vouchers in Escambia County from 
the previous school year. 

 
Vouchers for students with disabilities. 
McKay Scholarships allow a parent who is 

dissatisfied with their child’s educational 
progress in a Florida public school to request a 
voucher (“McKay Scholarship”) for a private  
school or to enroll their child in another public 
school that better meets their child’s needs. 
Students with disabilities include those who are 
mentally handicapped, speech and language 
impaired, deaf or hard-of-hearing, visually 
impaired, dual sensory impaired, physically 
impaired, emotionally handicapped, specific 
learning disabled, hospitalized or homebound, or 
autistic. The program began as a pilot with two 
students in 1999-00 and was expanded statewide 
in 2000-01. By the beginning of the 2002-03 

school year, 7,500 students with disabilities were 
receiving McKay scholarships to private schools. 

 
Legal Challenges 
A lawsuit (Holmes v. Bush) challenging the 

constitutionality of Florida’s Opportunity 
Scholarship Program was filed within 24 hours 
after passage of the A+ plan legislation in 1999. 
This case affects only the Opportunity 
Scholarship Program because McKay 
Scholarships for Students with Disabilities did 
not exist at the time the lawsuit was filed. For the 
past three years, Holmes v. Bush has been 
working its way through the state court system. 

In August 2002, the Circuit Court in Leon 
County ruled private school vouchers 
unconstitutional, stating that parental 
endorsement of the voucher payment to a private 
school is the equivalent of “indirect” aid to a 
“church, sect, religious denomination or 
sectarian institution” prohibited under Article 1, 
Section 3 of the Florida Constitution. While the 
case is on appeal, the 624 eligible students who 
have opted for private school vouchers in 2002-
03, will be able to proceed with their plans. 
Holmes v. Bush is expected to reach the Florida 
Supreme Court within the next year. 

 
Research on Florida’s  

Voucher Programs 
 
Research on the effects of school vouchers 

in Florida is at an early stage. To date, research 
has focused on Florida’s Opportunity 
Scholarship Program, which has received the 
most attention, even though it’s the smaller of 
Florida’s two voucher programs. At this point, 
we know very little about the McKay 
Scholarships for Students with Disabilities other 
than the number of participating students and 
schools.  

Impacts of Florida’s Opportunity 
Scholarship Program have been difficult to 
measure because few students have been eligible 
and subsequently elected to participate. By the 
end of the 2001-02 school year, only two public 
schools in Florida (both elementary schools in 
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Escambia County) had met the voucher criteria 
(two “F”s in four consecutive years).  In those 
schools, only 57 students had opted for a 
voucher to attend a private school.  

The majority of Florida parents with 
children in failing public schools keep their 
children where they are. Of those who leave, 
most select another public school. According to 
the Choice Office at the Florida Department of 
Education, of the 9,000 students in Dade, Orange 
and Palm Beach counties who became eligible 
for vouchers at the beginning of 2002-03 school 
year, only 580 (6.4%) opted for a private school 
voucher. Another 909 (10%) decided to go to 
another public school and that number is 
expected to grow throughout the year as a result 
of open enrollment. This response could change 
over time, for example, if many more students 
become eligible for vouchers or as parents 
become more familiar with the program.  

Nevertheless, preliminary analysis offers 
some lessons to be learned. Various researchers 
have been examining the effects of school 
vouchers in Florida. Similar research questions 
have been asked from different perspectives. 
This policy brief summarizes these findings to 
inform policymakers as they continue to shape 
the A+ Plan to meet its intended goals. 

 
Has the A+ plan been working? 
The consensus is generally yes. Overall, 

student performance on the Florida 
Comprehensive Assessment Test (FCAT) has 
improved. The incentives appear to be working. 
However, the A+ Plan has multiple incentives 
for schools: the threat of vouchers, the stigma of 
an “F” grade, and increased resources targeted to 
low-performing schools. The A+ Plan also has 
consequences for students, retention in 3rd grade 
if FCAT reading proficiency standards are not 
met and inability to earn a regular high school 
diploma without passing the FCAT. 

 
Do vouchers have an impact? 
Whether vouchers have an impact depends 

on the problem they are intended to solve: low 
student achievement, the racial/ethnic 

achievement gap, or parental dissatisfaction with 
their child’s education.  What does research tell 
us?  It’s too early to tell, but preliminary research 
provides lessons to be learned. 

 
Student achievement 
Some evidence supports the claim that 

vouchers have a positive impact on student 
achievement, particularly for African American 
students. A RAND study found no overall 
evidence of benefit or harm, and a small positive 
effect on the achievement of African-American 
students. A Brookings Institution study also 
found a positive effect for African American 
students.  

Other research has found that while 
vouchers may result in improved student 
achievement, particularly for African Americans, 
the effects tend to be small or limited in scope. A 
Stanford University study indicated that the 
effects of vouchers are smaller than voucher 
proponents claim. In analyzing Florida’s school-
level FCAT data, research at the Economic 
Policy Institute found a voucher effect of only 
0.02 standard deviation which is equivalent to a 
very small (0.8% percentile) increase in FCAT 
achievement.  

 
Reducing the Achievement Gap 
The Brookings Institution found that 

vouchers reduced the achievement gap between 
blacks and whites, but only in one grade. Dr. 
Douglas Harris at the Economic Policy Institute 
questions whether it’s realistic to expect much 
impact on this outcome. First, there is no clear 
explanation why African-American students 
show greater gains than other students. Further 
research beyond test score analysis would be 
needed to shed light on this question. Second, 
even if the effect for African American students 
is real, it is not likely to have any sizeable effect 
on the achievement gap.  

Assume that a large voucher is offered to 
all African American K-12 students in Florida. If 
50% of the students actually accept the voucher, 
40% of those students actually stay at their new 
school, and their test score gains are large 
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enough to reduce the gap by 20%, the state’s 
overall test score gap would decrease by only 
4%. Not enough students would actually opt for 
the vouchers and for those that do, the effects 
would not be large enough to reduce the 
achievement gap found in the general student 
population. 
 

Parent Satisfaction 
Vouchers appear to have their greatest 

impact on improving parent satisfaction. 
National research studies generally shows that 
parent satisfaction is higher for those who switch 
schools, not surprising given that dissatisfied 
parents are more likely to take this action.  
However, this finding does suggest that vouchers 
may have their greatest benefit on important 
outcomes other than student achievement.  

 
Is the threat of vouchers an incentive for 

schools to improve? 
If the threat of vouchers motivates schools 

to improve, we would expect lower performing 
schools (because they are at greater risk of 
qualifying for vouchers) to show greater 
improvement on FCAT scores than higher 
performing schools. This motivation should be 
strongest for “F” schools.  

Research undertaken by Dr. Jay Greene at 
the Manhattan Institute for Policy Research 
found that lower graded schools do show greater 
FCAT improvement than higher graded schools, 
even when regression to the mean is taken into 
account.  Also, when schools in the low “D” 
range are compared with those in the high “F” 
range, the latter show greater gains than the 
former even though they are similar in most 
respects, except their motivation to improve. If 
the “F” school receives a second “F” in the next 
three years, all of their students become eligible 
for vouchers. It has been estimated that the 
following additional per-pupil spending would 
be required to achieve equivalent results: $888 
for reading, $3,484 for mathematics and $2,805 
for writing. Higher dollar amounts reflect that 
greater gains were achieved in those subject 
areas. 

Critics note that the difference between the 
low “D” and high “F” school improvements is 
small. However, the effect actually may be 
underestimated because low “D” schools would 
be expected to respond to the threat of vouchers 
to some extent as well.  

 
 What else could explain the effects of the 

A+ Plan? 
The threat of vouchers is a possible 

explanation for the impact of the A+ Plan. 
However, the plan includes multiple incentives 
for low-performing schools that could account 
for results: the threat of vouchers, the stigma of 
an “F” grade, or increased resources targeted at 
low-performing schools. Even before Florida’s 
voucher program went into effect in 1999, 
evidence indicates that other factors played a role 
in school improvement. For example, in 1995, 
158 schools were identified a “critically low” by 
1997 this number had declined to 30 schools 
statewide.  

 
Will the effects of the A+ Plan continue 

into the future? 
Effects could plateau, expand or decline. In 

other areas of the nation where voucher 
programs have been operating longer than in 
Florida, the effects of vouchers have peaked after 
about three years. In Florida, vouchers have been 
examined only in the short term. From 1999-00 
to 2001-02, students in only two schools in 
Florida were eligible to receive vouchers. Even 
for these students, researchers have had only one 
year of gain scores because FCAT testing was 
not expanded to grades 3-8 until 2000-01. 
Additional years of data on more schools and 
students should be analyzed before we can 
determine whether effects are real or sustained 
over time and across student populations.  

 
Unintended Consequences.  
Anecdotal evidence from Florida, Virginia 

and California suggests that schools respond to 
accountability plan incentives in unintended 
ways: i.e., strategies for Gaming” the system. 
“Teaching to the test” has received the most 
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attention thus far, although this method could be 
positive if the test is tied to real, meaningful 
standards. In Florida, preliminary data analysis 
indicates that some schools “punish to the test” - 
increasing discipline of low performing students 
around test time. In Virginia, schools have been 
found to “feed to the test; use the school nutrition 
program to boost calories on test days. In 
California, schools have been “zoning to the 
test”; re-zoning schools to redistribute poor-
performing students among public schools.  And, 
Resource manipulation: Some schools assign 
their best teachers to the grades that are tested, 
targeting resources to those being tested. 
 
Shaping the test pool: Early evidence suggests 
that schools in Florida threatened by vouchers 
are identifying more low performing students as 
learning disabled. School grades are based on 
test results for standard curriculum students only.  
 

Are vouchers cost-effective? 
 Voucher proponents argue that private 

schools could achieve the same or better results 
than public schools at a lower cost.  Opponents 
counter that private schools accepting voucher 
students save money in undesirable ways, for 
example, by limiting special services and 
extracurricular activities or hiring less 
experienced teachers at lower salaries than their 
more experienced counterparts in public schools. 
So far in Florida, no hard evidence supports 
either claim. 

Conclusion 
 

In summary, definitive conclusions about 
the effects of vouchers in Florida would be 
premature for several reasons. First, Florida has 
had the only statewide voucher programs in the 
nation; but as of the 2001-02 school year, only 
two schools had met the criterion making 
students eligible to receive vouchers (two “F” 
grades in a consecutive four-year period). 

Second, vouchers are only one component 
of Florida’s A+ accountability plan, so their 
effects are difficult to isolate from school 

grading, consequences for students, and other 
elements of the plan. 

Third, researchers have not had access to 
individual student achievement data in Florida, 
so studies to date have relied on aggregate 
school-level data, which have serious limitations. 
School-level gains are calculated based on year-
to-year comparisons of different sets of students 
attending the same grade tested. Therefore, 
effects could be attributed to differences in 
student characteristics between year 1 and year 2. 
To remedy this problem, researchers need access 
to student level data, so that for each school, 
gains can be computed for individual students as 
they progress through different grade levels. 

 
          Future Research 
 
The primary contribution of future research 

will be to help policymakers understand what are 
the real effects of the A+ Plan and how they can 
minimize its unintended consequences while 
maximizing its positive benefits.  

The A+ Plan has had an impact. Why? We 
don’t know. A major challenge will be teasing 
out alternative explanations: the threat of 
vouchers, stigma avoidance, and targeted 
resource distribution to low-performing schools. 
Schools respond to incentives in both desired 
and undesired ways. Policymakers need to know 
what mechanisms lead to good outcomes so that 
they can make policy adjustments accordingly. 

Dr. David Figlio at the University of 
Florida, with colleagues at the Urban Institute 
and Princeton University, is conducting a multi-
year evaluation of Florida’s A+ Plan. This 
project just completed a survey of Florida’s 
teachers and principals selected from a universal 
sample of public schools in Florida. Results are 
expected to be published in late Fall of 2002. 

By the summer of 2003, Florida will have 
experienced a major change in its school grading 
system that should affect stigma avoidance but 
not the threat of vouchers. At that time, quasi-
experimental studies can be conducted, teasing 
out the effects of vouchers and other A+ Plan 
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components, looking at different patterns of 
school grades across multiple-years.  

At this point, moreover, research can play a 
more important role by focusing on broader 
questions, specifically: (1) How can the A+ Plan 
and all its elements best achieve its intended 
goals? (2) What adjustments need to be made? 
(3) What other elements or approaches would 
make the plan more effective? (4) What is the 
impact of the A+ Plan on the local educational 
system, schools, and students? (5) How are 
various groups of students and schools 
differentially affected by these voucher 
programs? 

If Florida’s voucher program is ruled 
constitutional by the Florida Supreme Court, 
research will have a key role in informing policy-
makers and the public about the specific effects 
of vouchers. This court ruling in Holmes v. Bush 
may influence the decisions of policymakers as 
they seek to revise the A+ Plan or help parents of 
voucher-eligible children to make their choice 
decisions.  Among the most important questions 
to ask are: 

1.Who chooses vouchers and why? What 
are the characteristics and public school 
experiences of voucher students and their 
parents?  

2. Who doesn’t choose vouchers? Why 
not? What are the characteristics and public 
school experiences of these parents and 
students?  

3. How do vouchers affect students and 
parents? Do voucher students show significant 
achievement gains? Are these gains greater than 
for students who do not choose vouchers? Do 
vouchers affect different groups of students in 
different ways? Does parental satisfaction 
improve?  

4. How do vouchers affect public and even 
private schools? To what extent does the threat 
of vouchers motivate schools to improve? What 
changes do schools and school districts make in 
response (a) to the threat of vouchers and (b) to 
having their students actually become eligible for 
vouchers?  For both proponents and opponents, 
private (religious) school vouchers will continue 

to be a moral issue. What do we want as a 
society? Do we want universal choice so that 
parents can make their own decisions about 
what’s best for their children, particularly low-
income parents whose children are most likely to 
be trapped in low-performing schools? 

Or do we want public schools to be the only 
form of publicly funded K-12 education because 
we value public schools as fundamental 
democratic institutions? 

For reasons of democracy, equity, and school 
quality, some people--including practitioners and 
researchers--have suggested separating the 
accountability and choice issues. The question, 
“Should we have choice?” ultimately may not be 
a question that research can answer. It’s an issue 
that the citizenry must confront as other states 
and districts adopt vouchers and other forms of 
privatization in education. 

 
This policy brief was prepared for a May 

22, 2002 symposium hosted by Florida State 
University for policy-makers, educational 
practitioners, local school districts, university 
faculty and private sector policy groups. 
Symposium speakers included: 

Dr. Carolyn Herrington, Director, 
Florida Education Policy Studies, Learning 
Systems Institute, Florida State University, 
Tallahassee, FL. 

Dr. Jay Greene, Senior Fellow, 
Manhattan Institute for Policy Research New 
York, NY. 

Dr. Douglas Harris, Economic Policy 
Institute, Washington, DC. 

Dr. David Figlio, Professor, University of 
Florida Department  of Economics. 
 

MESSAGE FROM THE  

PEA PREZ    

(Continued from  p. 1). 
Kenneth K. Wong 

       To position the association for many more 
years to come, we need to start thinking about 
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venues for institutional expansion.  At issue is 
the extent to which PEA can add value to our 
professional undertakings.  Among the issues 
that we may want to address include:    
1) How to maintain a focus on the politics of 
education when many of our research projects 
are oriented toward policy analysis? 
2) How to cultivate the commitment of the next 
generation of scholars to build on the 
accomplishments of the founding generation of 
the PEA? 
3) How can PEA expand its institutional ties to 
AERA, APSA, and other professional and policy 
associations to promote the study of school 
politics and governance? 
4) How do we make political analysis a central 
concern of current debate on school reform? 
5) How do we strengthen our international 
contacts? 

To be sure, we have a solid foundation for 
significant expansion in the next two years.  To 
start off, I receive great support from V. Darleen 
Opfer (Secretary) and Lance Fusarelli 
(Treasurer).  Bruce Cooper has provided 
outstanding stewardship in reviving the PEA 
Bulletin.  Bruce and I have discussed the 
prospect of replacing the printed version with an 
electronic version of the Bulletin (including 
Web-based) beginning with the next issue. If you 
have any suggestions on the e-Bulletin, please 
contact Bruce at BSCOOPERPH@aol.com.  
Our immediate past president, Hanne 
Mawhinney, has kindly completed the 
challenging (and thankless) task of updating the 
membership database.  This database will 
empower us to launch a more aggressive 
campaign to recruit new members, including 
graduate students (with reduced membership 
fee), policymakers, and practitioners.  Please 
send any suggestions on membership 
recruitment to the new treasurer, Lance at 
fusarelli@fordham.edu.   

As an initial step toward institutional 
expansion, I have called upon some of you to 
serve on three committees.  First, Robert 
Crowson is chairing a committee on the future of 
PEA.  Members of the committee include Ben 

Levin, Jay Scribner, Doug Mitchell, Bill 
Firestone, Dorothy Shipps, and Bob Johnson. Its 
goal is to examine the association’s mission, 
organizational structure, membership recruit-
ment, research agenda, and its relationship with 
AERA in the future.  A draft of the committee 
report is included in this Bulletin for your inputs 
at the UCEA.  You can also email comments to 
Bob at Robert.Crowson@vanderbilt.edu.    

Second, I have appointed a Committee on 
Research and Development in Urban Politics of 
Education to explore new channels through 
which PEA members can interface with urban 
leaders.  Members of the committee are: Peter 
Cistone (chair), Marion Orr, Dorothy Shipps, 
Rey Contreras, Bruce Cooper, and V. Darleen 
Opfer.  The committee expects to circulate a 
draft report by January 2003. 

Third, I have established the Committee on 
Research and Development in State Politics of 
Education to consider multiple forums for 
exchange with policymakers and practitioners at 
the state level.  Members of the committee 
include: Jim Cibulka (chair), Stephen Clements, 
Michael McClendon, Karen DeMoss, Lance 
Fusarelli, and Andrea Rorror.  A draft report will 
be ready by December 2002. 

In addition, we are making progress on 
several fronts.  First, the Roald Campbell Award 
Selection Committee has issued a call for 
nominations (see this issue of the Bulletin).  
Members of the committee include David Monk 
(chair), Jerry Sroufe, and John Rury.  Second, 
our publication committee has kept our 
yearbooks on track.  Members of the committee 
include John Fitz (chair), Marion Orr, Catherine 
Lugg, Darleen Opfer, Lisa Cuerars (Sage), and 
Phil Altbach (Editor, Education Policy).  
Michael K. McLendon and James Hearn jointly 
edit the 2003 yearbook on the politics of higher 
education.  Bonnie Johnson and Bill Boyd will 
edit the 2004 yearbook on the politics of 
curriculum and instruction.  Finally, the Peabody 
Journal of Education will set aside one issue 
every two years for a PEA symposium.  I am 
editing the first symposium on the politics of 
accountability.  Please send your suggestions on 
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future yearbooks and symposia to John Fitz at 
jcardiff@ntlworld.com.   

In short, the PEA needs your continual 
support.  As always, please feel free to email me 
at ken.wong@vanderbilt.edu on how we can 
improve our association.  Thank you, 

Kenneth Wong, President of PEA 
 

Announcements: 
At the 2001 PEA annual meeting changes 

in membership renewal procedures were 
adopted. These changes respond to several 
ongoing issues faced by the association for 
several years. It was decided that membership 
would run from January to January beginning 
January 2001.  Membership fees of $25 provide 
the following benefits: 

�� A Politics of Education Yearbook double 
issue of the Educational Policy 
beginning with the January/February 
2001 edition. 

�� Yearly editions of the PEA Bulletin 
�� Two Newsletters offering advance 

information on upcoming conferences 
with affiliated groups and other 
opportunities. 

�� Potentially significantly reduced 
purchase costs for a Politics of 
Education Handbook (currently under 
development). 

�� Connections with other scholars and 
practitioners of politics of education, 
through website and conference 
sessions. 

�� Access to awards given in the following 
cycle: 

2002: Outstanding Dissertation Award recognizes 
excellence in doctoral research in the politics 
of education.  It is offered biannually. 

2003: Roald Campbell Award recognizes those 
individuals who link research to practice. 

2004: Outstanding Dissertation Award  
2005: Service Award is given in recognition of service 
to the Association 
2006: Stephen K. Bailey Award is given to recognize 
outstanding research in the field. 
 

_________________________________________ 

MESSAGE FROM THE 
TREASURER:  

LANCE D. FUSARELLI 
FORHDAM UNIVERSITY  

        The Politics of Education Association is a 
wonderful organization, filled  with interesting 
and fascinating people.  The PEA Bulletin is 
terrific, and the PEA Yearbooks are excellent 
sources of cutting-edge research in the field.  
       Unfortunately, as great as PEA is, we can’t 
operate without membership and funds.  While a 
solid, core group of members regularly pay their 
dues, the majority of people who receive our 
Bulletin do not (only about 1 in 4 members is  
currently paid up).  As a result, quite frankly, we 
are going broke.  One cost-cutting measure is to 
produce an electronic version of the Bulletin,  
which we plan to begin in 2003.   
       When you renew your membership, please  
include your email address so that we may keep 
the database current.  EVERYONE’S current 
membership expires December 31, 2002. 
Anyone seeking to remain a member of PEA for 
2003 must send me a check payable to PEA for 
$25  (PLEASE pay for only 1 year at a time).    
     Your new treasurer is a simpleton,  all too 
easily confused, so let’s try to keep the process as 
simple as  possible.  Anyone who has not paid by 
the next PEA meeting (in Chicago at  AERA) 
will be dropped from the membership rolls 
forever.  All past debts are  hereby forgiven.  But 
if you don’t pay $25 for next year’s dues, you 
will  dropped from the mailing list for eternity 
and relegated to a life of dreary  ignominy, 
wandering purposelessly through the vast chasm 
of an empty life  (much like Al Gore).  So, 
please, make my holiday and send me your dues 
for  2003. 
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Politics of Education Association 
Membership Application 

Name (please print): 
 
 ______________________________________  
 
Title: ________________________________ 
 
Affiliation:______________________________ 
 
Address: 
______________________________________ 
 
City/State/Zip code: 
 
Phone: (      ) ____________ 
 
For the quickest news on events and opportunities, 
please include your email address, to receive the 
next Bulletin. 
 
Email Address:___________________________ 
 
Enclosed please find a check to PEA for
 ______$25 for full membership 

  
Send to Lance D. Fusarelli, Treas., Fordham 
University Graduate School of Education, 113 W. 
60th Street, #1119, New York, NY 10023, USA. 
 
 
 Politics of Education BULLETIN is an 
official publication of the Politics of 
Education Association (PEA) and is published 
three times per year. We encourage authors to 
submit essays on topics of interest in school 
policy and politics to the co-editors: 
 

Bruce S. Cooper and Lance D. Fusarelli, 
Fordham University Graduate School of 
Education, 113 West 60th Street, Suite 1119, 
New York, NY 10023.  Or call Bruce Cooper 
at 212-875-9371 or Lance Fusarelli at 212-
636-6438.  Email addresses are: 

 
 bscooperph@aol.com or  fusarelli@hotmail.com  
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If you want to insert your own picture or logo, click 
the placeholder picture above or the logo on page 2. 
Click Picture on the Insert menu, and then locate your 
artwork. 

To resize a picture and keep its original dimensions, 
click it and drag a corner handle. To reshape a picture, 
drag one of the middle handles. To crop a picture, press 
Shift and drag either a corner or middle handle. 

Once you have made changes to the newsletter title 
and picture, you will want to begin to replace the text in 
the body of this template. There are two ways to do this: 

�� Select the text and type your information. 

�� Select a new style from the Style list. For example, 
this style was created using the List Bullet style. 
Then, type your text. 

To change the shading of text borders, click the 
cursor on the shaded area. On the Format menu, click 
Borders And Shading. On the Shading tab, select a new 
option. On the Borders tab, you can add, remove, or 
change the color of a border. 

There are several section breaks in this template. To 
create additional section breaks, use the Break 
command. If nonprinting characters are turned on, you 
can identify breaks by the double, dotted lines. If the 
nonprinting characters are not visible, select the Hidden 
Text option under Nonprinting Characters (Tools-
Options-View). To insert a section break, click Break 
on the Insert menu and then select Continuous. 

Use this same method to create a page or column 
break. On the Insert menu, click Break. Then select 
either Page Break or Column Break. 

If you want to remove the vertical line, click 
Columns on the Format menu. In the Columns dialog 
box, select the Line Between check box. You can also 
use the Columns dialog box to change the number and 
placement of columns in your newsletter. 

SAVING YOUR NEWSLETTER 

Click Save As on the File menu, and then type a 
unique name. 

 

HIGHLIGHTS 

HOW TO ADD A GRAPHIC TO THIS NEWSLETTER 
HOW TO CHANGE THE COLOR OF TEXT 

HOW TO IMPROVE YOUR NEWSLETTER PRINT QUALITY 



 

Newsletter Questions & Answers 

Readers Write 
How do I change the color of 
text? 

 
To change the color of text, 
select the appropriate 
paragraph. On the Format 

menu, click Font and select a color 
from the Color list. 
 
 
Question 

Extra space seems to appear between the 
lines as I type sometimes? What is 
wrong? 

 
Answer 
Nothing. Depending on how fast you 
type and the speed of your computer, 
you may experience momentary lapses 
of proper line spacing. Word will 
automatically redraw the screen. 
 
 
Question 

I would like to mail my newsletter in an 
envelope. How do I remove the indicia 
and return address frames? 

Q&A 
I would like to change the color of my 
picture. Can it be done? 

Yes. To change the color of a picture, 
double-click it to activate the picture. 
Select the area you want to color. On 

the Format menu, click Drawing 
Object. On the Fill tab, under Color, 
select a new color. In the Picture 
dialog box, click Close Picture to 
return to the newsletter. 
 
 

Q: Printing 
What is the best way to print this 
newsletter? 

 

A: Printing 
Print page 2 on the back of page 1. 
Fold the sheet in thirds, like a letter, 
and mail with or without an envelope. 
For best results, use a medium- to 
heavy-weight paper. If you’re mailing 
without an envelope, seal your 
newsletter with a label. 
 

QUESTION 

How do I add a graphic to my 
newsletter? 

 
ANSWER 
On the Insert menu, click Frame. 
Then, place the cursor where you want 
to insert your graphic. Click and drag 
the cursor until the frame is the correct 
size. On the Insert menu, click Picture, 
and then locate your graphic. 
 
 

How do I remove the vertical 
column lines? 

Click the cursor in the section 
you want to change, and click 
Columns on the Format menu. 
Click the Line Between box to 

turn the column lines to the off 
position. 

 
Many  styles of various sections are 
shown on this page.  One style is the 
Format Drop Cap command, which 
you can use to create the large letters. 
Quickly copy and paste styles using 
the edit copy and edit paste 
commands.  

Q 
A 
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